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Technical support

As part of Symantec Security Response, the Symantec global Technical Support
group maintains support centers throughout the world. The Technical Support
group’s primary role is to respond to specific questions on product feature/
function, installation, and configuration, as well as to author content for our
Web-accessible Knowledge Base. The Technical Support group works
collaboratively with the other functional areas within Symantec to answer your
questions in a timely fashion. For example, the Technical Support group works
with Product Engineering as well as Symantec Security Response to provide
Alerting Services and Virus Definition Updates for virus outbreaks and security
alerts.

Symantec technical support offerings include:

m A range of support options that give you the flexibility to select the right
amount of service for any size organization

m  Telephone and Web support components that provide rapid response and
up-to-the-minute information

m  Upgrade insurance that delivers automatic software upgrade protection

Content Updates for virus definitions and security signatures that ensure
the highest level of protection

m  Global support from Symantec Security Response experts, which is
available 24 hours a day, 7 days a week worldwide in a variety of languages
for those customers enrolled in the Platinum Support Program

m  Advanced features, such as the Symantec Alerting Service and Technical
Account Manager role, offer enhanced response and proactive security
support

Please visit our Web site for current information on Support Programs. The
specific features available may vary based on the level of support purchased and
the specific product that you are using.

Licensing and registration

If the product that you are implementing requires registration and/or a license
key, the fastest and easiest way to register your service is to access the
Symantec licensing and registration site at www.symantec.com/certificate.
Alternatively, you may go to www.symantec.com/techsupp/ent/enterprise.html,
select the product that you wish to register, and from the Product Home Page,
select the Licensing and Registration link.

Contacting Technical Support

Customers with a current support agreement may contact the Technical
Support group via phone or online at www.symantec.com/techsupp.

Customers with Platinum support agreements may contact Platinum Technical
Support via the Platinum Web site at www-secure.symantec.com/platinum/.



When contacting the Technical Support group, please have the following:

Customer Service

Product release level

Hardware information

Available memory, disk space, NIC information
Operating system

Version and patch level

Network topology

Router, gateway, and IP address information

Problem description

m  Error messages/log files

m  Troubleshooting performed prior to contacting Symantec

m  Recent software configuration changes and/or network changes

To contact Enterprise Customer Service online, go to www.symantec.com, select
the appropriate Global Site for your country, and then choose Service and
Support. Customer Service is available to assist with the following types of

issues:

m  Questions regarding product licensing or serialization

m  Product registration updates such as address or name changes

m  General product information (features, language availability, local dealers)
m Latest information on product updates and upgrades

m Information on upgrade insurance and maintenance contracts

m Information on Symantec Value License Program

m  Advice on Symantec's technical support options

m  Nontechnical presales questions

m  Missing or defective CD-ROMs or manuals
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Managing Symantec
AntiVirus

This chapter includes the following topics:

m  About managing Symantec AntiVirus

m  Managing with the Symantec System Center

m  About clients and servers

m  About server and client groups

m  Managing with server groups

m  Enhancing server group security

m  Managing with client groups

m  Configuring clients directly

m  Changing an unmanaged client into a managed client (and the reverse)

m  How settings propagate

About managing Symantec AntiVirus

Using the Symantec System Center, you can perform Symantec AntiVirus
administrative operations such as installing antivirus protection on
workstations and network servers, updating virus definitions, and managing
Symantec AntiVirus servers and clients. In addition to the Symantec System
Center, you can also use configuration files (Grc.dat) to configure Symantec
AntiVirus clients. You can use configuration files if you want to use a third-
party tool to perform remote configuration on your network.
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Managing with the Symantec System Center

Console tree tab

Top server group level

When the Symantec System Center runs, it displays a system hierarchy of
server groups, client groups, and servers displayed in an expandable/collapsible
tree. The system hierarchy is the top level that contains all server groups and
client groups.

Note: The system hierarchy is not populated until you install at least one
Symantec AntiVirus server.

To start the Symantec System Center

¢ Onthe Windows taskbar, click Start > Programs > Symantec System Center
Console > Symantec System Center Console.

"fii Symantec System Center - [Console Root'Symantec System Center!System Hiel =10 =|
| onsok wedow wep D W @] -18x
“ Action  iew  Favorites  Tools H o= | | [ =} | b | @ |”@:5| ﬂ |J b b"l" ﬂ 2 i |

Tree I Favorites | Server | Status | Metwark 03 | Address |
(21 Console Root - @ Prodl Wirus Found! ‘Windaws NT (IP)-155.64.1...
EI@ Symantec System Certer i @ Prodl2 Frimary ‘indows NT (IP}-155.64.1...
=] Q_l System Hierarchy @ Prod03 Disabled ‘Windaws NT (IP)-155.64.1...
@ Albary 8 Prodl4 Windaws NT (IP}-155.64.1...

Contents of object
selected in tree appear
in right pane

Locked server

group

Unlocked server
group

Einringham
Eloorrington

Client groups

Groups

D Finance

(-7 Boston
-3 Buffalo
-3 Charlotte |
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Using console views

Each product management snap-in makes a new product view available within
the Symantec System Center console. For example, when you install the
Symantec AntiVirus management snap-in, the Symantec AntiVirus view is
added, which includes fields related to Symantec AntiVirus, such as Last Scan
and Definitions.

The columns that appear in the right pane change based on the selected view.
When System Hierarchy is selected, the Console Default View includes the
following data columns:

m  Name

m  Status

m  Primary Server
m  Valid State

Table 1-1 lists the data columns in the Symantec AntiVirus view.

Table 1-1 Data columns in the Symantec AntiVirus view

Object selected in left pane Data columns that appear in right pane

System hierarchy icon Server Group
Status

Definition Sharing
Newest Definitions

Status of server updates

Server
Type
Status
Last Scan

Server group icon

Definitions

Version

Scan Engine

Address

Status of client updates

Groups icon (for client groups)

Group Name
Configuration Change Date
Number of Clients
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Table 1-1 Data columns in the Symantec AntiVirus view

Object selected in left pane Data columns that appear in right pane

Client
User
Status
Last Scan

Client group icon or Server icon

Definitions
Version
Scan Engine
Address
Group

[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
| Server

Changing console views

Unless you change the view, the Symantec System Center console displays the
Console Default View. The other views available depend upon which managed
Symantec AntiVirus products you have installed.

To change console views

1 Inthe Symantec System Center console, in the left pane, expand System
Hierarchy.

2 Onthe View menu, in the list that appears at the bottom of the menu, select
a view.

Saving console settings

When you close the console, you are prompted to save console settings for the
Symantec System Center.

To save console settings
¢ Do one of the following:

m  Click Yes if you want to see the same console view the next time that
you launch the Symantec System Center.

m  Click No if you want to see the last saved view the next time you launch
the Symantec System Center.
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Choosing No may result in lost settings. For example, if you change
settings for an attached Quarantine Server, and then choose No when
exiting the console, the changes are not retained for the Quarantine
Server.

Note: If a newer version of MMC is present on the system, you may need to
upgrade to the newer version to save changes upon exiting the Symantec
System Center console.

Understanding Symantec System Center icons

The Symantec System Center uses icons to represent the different states of
computers that are running Symantec managed products. For example, if the
server group icon in the server group view appears with a padlock icon, the
server group must be unlocked with its password before you can configure or
run scans for the computers in the server group.

Table 1-2 lists the Symantec System Center icons.

Table 1-2

Symantec System Center icons

Icon

Icon descriptions

&

Highest level object representing the system hierarchy, which contains all
server groups.

Unlocked server group or client group. Compare this icon to the locked
server group icon. For security reasons, all server groups default to locked
when you start the Symantec System Center.

Locked server group. You must enter a password before you can view the
computers in the server group to configure and run updates and scans.

An issue needs to be resolved in this server group. For example, there may
not be a primary server assigned to the server group or a server may be
infected with a threat.

Symantec AntiVirus server running on a supported Windows or NetWare
computer. Compare this icon to the next one, which is the primary server for
the server group.

mow & e U

Symantec AntiVirus primary server running on a supported Windows or
NetWare computer.
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Table 1-2

Symantec System Center icons

Icon

Icon descriptions

B

Unavailable Symantec AntiVirus server. This icon appears when
communication is severed between the Symantec AntiVirus server and the
Symantec System Center console. The communication error may result
from one of several different causes. For example, the server system is not
running, the Symantec software has been removed, or there could be a
network failure between the console and the system.

A virus was detected on the computer that is running Symantec AntiVirus
server.

U <

A threat other than a virus, such as adware or spyware, was detected on the
computer that is running Symantec AntiVirus server.

Note: If Symantec AntiVirus detects a virus and a threat other than a virus
on the same computer, the virus icon appears.

)

Symantec AntiVirus client running on a supported Windows computer.

When you select this computer, you view options only on that computer.

A virus was detected on the computer that is running Symantec AntiVirus
client.

a @

A threat other than a virus, such as adware or spyware, was detected on the
computer that is running Symantec AntiVirus client.

Note: If Symantec AntiVirus detects a virus and a threat other than a virus
on the same computer, the virus icon appears.

iy,

An issue needs to be resolved with this client. For example, virus definitions
files may be out-of-date or the client group to which the client was assigned
is no longer valid.

The status field in the Symantec System Center console indicates the actual
problem.

[

The computer, which runs Symantec AntiVirus client software, is not
currently connected to the network.

You must enable a setting for the Symantec System Center console to show
when clients are not connected to the network.
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Showing when clients are offline

You can configure the Symantec System Center console to show when
computers running Symantec AntiVirus client software are not currently
connected to the network. The icon in the last row of Table 1-2 indicates that the
client is offline.

To show when clients are offline

1 Inthe Symantec System Center console, on the Tools menu, click SSC
Console Options Properties.

2 Inthe SSC Console Options Properties dialog box, on the Client Filter tab,
under Group Options, check Indicate when clients are offline.
This option is unchecked by default.

Showing client Auto-Protect status

You can configure the client or server icon to appear in the Windows system
tray.

The icon shows a client or server’s Auto-Protect status as follows:

m  When Auto-Protect is enabled, a check mark appears next to Enable Auto-
Protect and the icon appears as a full shield.

m  When Auto-Protect is disabled, the icon is covered by a universal no sign (a
red circle with a diagonal slash).

Discovering computers and refreshing the console

At the first startup of a newly installed Symantec System Center console, the
console will ping the network to find all available computers running Symantec
AntiVirus servers. As soon as the servers respond, they are added to the console.
Connected workstations running a managed Symantec client product are added
when their parent server is selected in the console tree.

If you start servers that are running a manageable Symantec product while the
Symantec System Center is already running, you may need to locate the server
using the Find feature or Discovery Service so that it will display in the server
group view.

You can also use Discovery to locate network computers on which Symantec
AntiVirus is not installed.
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Using the Discovery Service

The Symantec System Center console runs a single Windows NT service, the
Symantec System Center Discovery Service (Nsctop.exe). This service is
responsible for discovering the computers running Symantec AntiVirus server
that appear in the Symantec System Center console. The Discovery service also
populates the Symantec System Center console with objects.

You can choose one of the following Discovery types:

m  Load from cache only

m  Local Discovery

m Intense Discovery

See “Understanding Load from cache only discovery type” on page 22.
See “Understanding Local Discovery” on page 22.

See “Understanding Intense Discovery” on page 23.

How discovering computers on the network works

To discover computers on the network, a computer running Symantec AntiVirus
server sends a ping packet to a computer running Symantec AntiVirus client.
The ping program verifies that the remote computer exists and can accept
requests. When the Ping Discovery Service (Intel PDS) hears a ping, it responds
with a pong packet. Ping and pong packets are about 1 KB. A successful ping-
pong discovery ensures that the computer is working.

The pong also provides valuable information, such as the following:
m  Date of the computer’s virus definitions files
m  When the computer was last infected

Both IP and IPX pings are sent to the remote computer running Symantec
AntiVirus server to determine what type of protocol it uses.

Pings are also sent that support Norton AntiVirus Corporate Edition and
LANDesk Virus Protect, legacy versions of Symantec AntiVirus.

The data from the computer running Symantec AntiVirus client is stored on the
computer running Symantec AntiVirus server that is the client’s parent server.

The Symantec System Center console reads each parent server’s registry to get
the data that it displays in the console.

Following the completion of this process, Normal Discovery runs.
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Normal Discovery

Following all types of Discovery, a Normal Discovery runs. In a Normal
Discovery, the Symantec System Center console broadcasts to all servers that are
in unlocked server groups. This additional Discovery queries the primary server
of the server group for the list of secondary servers in its address cache.

The Symantec System Center console address cache stores information for all
servers that have ever reported to it. The primary server address cache contains
information for every server within the server group. The address cache
includes the names of all secondary servers and their IP addresses.

The Symantec System Center console compares its own address cache with the
address cache sent by the primary server. When a mismatch is identified, the
console pings the associated server. When the pong data returns, it is added to
all other servers in the list.

In this way, Normal Discovery can identify every server in the server group and
attempt to resolve information conflicts between parent servers.

Discovery Service WINS or Active Directory requirement

The Discovery Service requires the use of WINS (Windows Internet Naming
Service) or Active Directory name resolution. If you are attempting discovery in
an environment where WINS or Active Directory is not available you will need to
find at least one computer running Symantec AntiVirus server on your network
first. To find the computer, you can use the Find Computer feature or the
Importer tool.

See “Using the Find Computer feature” on page 27.

See the Symantec AntiVirus Reference Guide for information about the Importer
tool.

How to find NetWare computers

The Discovery Service may not find NetWare computers that are running IP
only. To find computers not located by the Discovery Service, you can use the
Find Computer feature.

See “Using the Find Computer feature” on page 27.

Understanding the Discovery Cycle configuration

The Discovery Cycle time-out is configurable. Depending on how you configure
your Discovery Service, you can set the time-out from 1 to 1440 minutes
between discovery attempts. By default, the interval is set to 480 minutes (every
8 hours).
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A new discovery is skipped if the last discovery is still running. For example, if
you have discovery set to run once a minute, and discovery takes 20 minutes, 19
discovery attempts will be skipped.

Changing the Discovery Cycle interval

While the Discovery Cycle interval can be changed, be aware that increasing the
interval can result in a display of outdated information from the Symantec
System Center console.

To change the Discovery Cycle interval

1 Inthe Symantec System Center console, on the Tools menu, click Discovery
Service.

2 Change the Interval In Minutes setting as necessary.

Understanding Load from cache only discovery type

Load from cache only offers the most basic type of discovery. It tries to refresh
all of the servers for which the Symantec System Center console contains
information in its address cache. Each server is then sent a series of pings to see
if the server will check back in, and to refresh information on the console.

Following the Load from cache only operation, the Normal Discovery runs.
See “Normal Discovery” on page 21.

Load from cache only is the default Discovery method. This reduces unwanted
traffic on the network when launching the Symantec System Center. In most
cases, you may find that choosing Load from cache only finds all of the servers
that you need to add to the Symantec System Center console.

Understanding Local Discovery

When you use Local Discovery, a broadcast of a ping packet is sent over the local
subnet of the computer running the Symantec System Center console. Intel PDS
services running on servers on the local subnet reply with pong data.

Local Discovery generates less ping noise, but is limited to working on the local
subnet. Local Discovery works very well on small subnets. In very large subnets,
you may experience better results using Intense Discovery.

Following a Local Discovery, the following Discovery types run:
m  Load from cache only
m  Normal Discovery

See “Normal Discovery” on page 21.
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Understanding Intense Discovery

Intense Discovery walks My Network Places on the local Windows 2000
computer or the Network Neighborhood on the local Windows NT computer,
and attempts to resolve all computers that it finds into a network address. Once
it has the network address, it attempts to send ping requests. You can configure
whether Intense Discovery walks the NetWare or Microsoft branches of the
network tree, or both.

From the Symantec System Center console, you can select any node beneath the
console root, and then choose Discovery Service from the Tools menu to
perform a new discovery of servers.

Following an Intense Discovery, the following Discovery types run:
m  Local Discovery

m  Load from cache only

m  Normal Discovery

See “Normal Discovery” on page 21.

Note: The ability of Intense Discovery to locate computers is limited by several
factors: the availability of a WINS server or Active Directory, network subnet
and router configuration, DNS configuration, and Microsoft domain and
workgroup configuration. Searching by IP address range in most cases is not
affected by these factors. For this reason, you may want to use IP Discovery.

Understanding IP Discovery
IP Discovery provides discovery by either IP address range or IP subnet range.

You may want to run IP Discovery only periodically. It can be used to discover
computers across the network.

Once the computers are in the address cache, you can then rely on the Load from
cache only method.

Running the Discovery Service

You manually run all forms of Discovery directly from the Symantec System
Center console.
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Note: The Discovery service uses WINS (Windows Internet Naming Service) or
Active Directory when browsing for new computers that are running Symantec
AntiVirus. If you are trying to discover new computers in an environment in
which WINS or Active Directory is unavailable, you may want to run the Find
Computer feature or the Importer tool first.

See “Using the Find Computer feature” on page 27.

See the Symantec AntiVirus Reference Guide for information about the Importer
tool.

Run the Discovery Service
You can run the Discovery Service and find servers with or without including IP

addresses and subnets.
To run IP Discovery

1 Inthe Symantec System Center console, in the left pane, select any node
below the console root.

2 On the Tools menu, click Discovery Service.

3 Inthe Discovery Service Properties window, on the Advanced tab, check
Enable IP Discovery.

Discovery Service Properties ﬂ

General Advanced |

V¥ Enable IP Discovery

Beginning of range: Subnet maszk:
|n.n.n.n |255.255.255.0
End of range: Scan type:

[0 0 00 1P Address x|

QK I Cancel Apply Help
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Once Enable IP Discovery is checked, an IP Discovery session runs
whenever you run an Intense Discovery. To run Intense Discovery without
also running IP Discovery, uncheck Enable IP Discovery.

In the Scan Type list, select one of the following:

m [P Subnet: The console broadcasts to each subnet.

m IP Address: The console pings every computer in the range of IP
addresses.

In the Beginning of range and End of range boxes, type the addresses.

If you clicked IP Subnet, type the subnet mask to refine the search.
IP Address search results appear in the Machine list box. IP Subnet search
results are displayed in the Symantec System Center console status bar.

You can also access IP Discovery functionality in the Find Computer dialog box.

See “Using the Find Computer feature” on page 27.

To discover without IP

1

In the Symantec System Center console, on the Tools menu, click Discovery
Service.

Discovery Service Properties ﬂ

General I Advanced

r~ Discovery Method

" Load from cache only " Netware Servers
" Local Discovery 7 NT Servers
* |rtense Discovery & NT and Metware Servers

- Discovery Cycl
Interval in minutes: 480 =3 Fiun Discovery Mow

- Cache Information

Clear local console machine cache,

and re-run digcovery with current Clear Cache Mow

settings.

r Intenze Discovery Properti

Mumber of intense discovery threads: 0=

QK I Cancel | Apply | Help
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In the Discovery Service Properties window, on the General tab, select one of
the following options:

m Load from cache only: This is the quickest method. The Symantec
System Center reads the list of servers and clients stored in the local
cache.

See “Understanding Load from cache only discovery type” on page 22.

m  Local Discovery: Broadcasts to the Symantec System Center console’s
local subnet. Servers respond immediately with information about
themselves and their clients. Each server’s server group will appear in
the console (unless filtered using the View menu). Load from cache only
will run as well.

See “Understanding Local Discovery” on page 22.

m Intense Discovery: This is the most thorough method. If you have a
large network, the discovery process may take a long time. The
Symantec System Center serially pings every server in the Network
Neighborhood. Server names appear in the message area of the
Symantec System Center console as they are found during the
discovery process. Intense Discovery also performs the same local
subnet broadcast as Local Discovery. Load from cache only and Local
Discovery will run as well.

For Intense Discovery, you can limit the search to NetWare or Windows
NT servers only, or search for both.
See “Understanding Intense Discovery” on page 23.

Under Discovery Cycle, select the Interval in minutes if necessary.

If you want to immediately run discovery, click Run Discovery Now, and
then click Close.
Only one discovery can run at a time.

Under Intense Discovery Properties, specify the number of intense
discovery threads.

You can choose any number of threads between 2 and 50. This setting
affects Intense Discovery sessions only. Each discovery thread is an
independent search for servers and clients. To maintain the most up-to-
date discovery information, select a lower discovery interval and a higher
number of discovery threads.

If you want to clear all server and client information out of the active
memory and address cache, and immediately run Discovery based on the
current discovery settings, under Cache Information, click Clear Cache Now.
When you clear the cache, unlocked server groups will be locked unless the
password for the server group has been saved.
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Note: Rebuilding a list of servers on a large network may take a long time.

Using the Find Computer feature

If you want to quickly find a server without having to expand and browse
through the tree, you can use the Find Computer feature. You can search using
TCP/IP or IPX addresses, or computer names.

The Find Computer feature is also useful if you install a server and then do not
see it in the tree view when you expand a server group or server. This may occur
for the following reasons:

m  The Symantec System Center may not automatically discover servers on
LAN segments separated by routers.

m  Servers may not be visible in the Network Neighborhood. For example,
Windows Internet Naming Service (WINS) servers or Active Directory may
not be replicated across network segments.

Servers on segments using only IPX protocol can also be skipped in the
discovery process. If you cannot locate some servers on your LAN, you can
locate them manually with the Find Computer feature in the Symantec System
Center console. Once you use the Find Computer feature to locate a server, you
can manage it from the Symantec System Center console.

Note: If you don’t have IPX installed, you may not see all NetWare computers in
the console. While you will be able to find the computers using the Find
Computer feature, installing IPX and TCP/IP ensures that the computers will be
discovered.

Finding computers by searching the local cache

Rather than search the entire network for computers, you can restrict the
search to those known to be stored in the local cache.
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To find computers by searching the local cache

1 Inthe Symantec System Center console, on the Tools menu, click Find

Computer.

i Find Computer

Losal Search | Natwork Discovery | Soan Network |

[_ O[]

SeachFar |

Match Tvpe: & Partial
" Exact

Exit
Help

et |

Hachine [SeverGowp [ Sewer

[ Tope [ Addiess

(|

|U Item(s] found.

1L
4

2 In the Find Computer window, on the Local Search tab, type the network

name of the server that you want to find.

3  Under Match Type, select one of the following:

m  Exact: Searches for a server name that is an exact match.

m  Partial: Searches for a server name that is a partial match.
If you leave the Search For text box empty and use Partial as the Match
Type, all computers in the local cache will appear when you run the search.

Finding computers using a network search

You can use a network search to find individual computers running the

Symantec AntiVirus server product.

Find computers

You can find computers using a network search or by specifying an IP address or

subnet range.

To find computers using a network search

1 Inthe Symantec System Center console, on the Tools menu, click Find

Computer.

2 Inthe Find Computer window, on the Network Discovery tab, specify
whether you want to use a TCP/IP address, IPX address, or a computer name

as the search criteria.
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Type the server address or computer name.

Click Find Now.

To use IP addresses to find a range of computers running Symantec AntiVirus
for servers

1

In the Symantec System Center console, on the Tools menu, click Find
Computer.

In the Find Computer window, on the Scan Network tab, select one of the
following:

m IP Subnet: Sends out a broadcast to each subnet.

m IP Address: Pings every computer in the range of IP addresses.

Type the addresses for Beginning of range and End of range.

If you clicked IP Subnet in step 2, type the subnet mask to refine the search.

Click Find Now.

IP Address search results will appear in the Machine list box. IP Subnet
search results will be displayed in the Symantec System Center console
status bar.

Locating found items in the Symantec System Center console

You can match an item in a Find Computer list to the same item as it appears in
the Symantec System Center console tree. To do so, the server group to which
the item belongs must be unlocked.
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To locate found items in the Symantec System Center console

1 Inthe Find Computer window, select the desired system.

etwork Dizcovery I Scan Metwork I
Search For: I
Exit |
Match Type: & Partial
" Egxact
Sync Item |

Machine | Server Group | Server | Type | =
@ Prodll Production Prodt Server War..
@) Prad02 Production Prad02 Prirary Server
@) Prod02 Fraduction Prod03 Prirary Server
8 Testn Testing TestO1 Server
@ Test02 Testing Test2 Server War..

Aol Accounting Accill Server War..

Testd3 Testing Test03 Serverwar..
) Prodns Production ProdD4 Disabled Se...
8 Prodl5 Production Prod0s Server
& Testns Testing Test04 Server
8 Acaiz Accaunting Aect2 Server
@ Aca0z Accounting Ao Disabled Se...
[y Accd Accounting Aect4 Primary Server =

|58 Item(s] found. |Search Complete. |

2 Click Sync Item to locate the selected item.

Using the Refresh feature

From the Symantec System Center console, you can refresh at the system
hierarchy, server group, or individual server level to validate active
communication with the list of currently displayed servers. However, the
Refresh feature does not find servers or server groups that may have been added
since the current session of the Symantec System Center started. If the refresh
determines that a server that previously appeared in the server group view is no
longer communicating, the unavailable server icon appears.

To use the Refresh feature

¢ Inthe Symantec System Center console, in the left pane, right-click the
system hierarchy, unlocked server group, server, or client group, and then
click Refresh.
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Auditing computers

Computers on your network that do not have Symantec AntiVirus running leave
holes open in your network security. You can run a network audit of remote
computers to determine the following:

m  Whether a Symantec AntiVirus component is installed and running.

m  The type of protection, such as server, client, or unmanaged client, that is
installed.

m  Whether antivirus software from other vendors or from Symantec (such as a
Symantec AntiVirus consumer version), including the type and version of
that software, is installed on the computer.

You must be able to log in as Administrator to the remote computers that you
are auditing.

Note: If a firewall is running on the remote computer, the network audit may not
be able to gather information.

Run a network audit and sync items

You can run a network audit to determine the antivirus protection status of the
computers that you manage. Once the status for the computers in the range
within which you searched is identified, you can locate selected computers by
syncing to them.
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To run a network audit

1 Inthe Symantec System Center console, on the Tools menu, click Find

Computer.
ol
Local Searchl Metwark Discoveryl Scan Metwork  Audit Metwork |
Beginning of range: Exit |
I . i i Save
Opti _—I
End of range: ﬁl
Help |
I . . . Lancel |
Spnc kem |
Machine | Server Group | Server | Type | Wersion | Addre:
1| | *
|D Item(z] found. | | v

2 Inthe Find Computer dialog box, on the Audit Network tab, type the
beginning and end of the IP address range.

3 To change the default options, click Options.
See “Setting network audit options” on page 34.
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4  Click Find Now to run the audit.

=8 _ioix]
Loal Search | etwork Discovery | Soan Networ  Audit Network |
Beginning of range: Exit
192 . 168 . 1 . 100 -
Options —I‘m
End of range: Heln
195 168 1120 ==
Syncliem|
Mach